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Chapter 1

Introduction

1.1 Overview

The purpose of QBTrak is to automate and enhance Tigerpaw’s batching process which transfers accounting data
from Tigerpaw to QuickBooks.

1.2 Automation & Enhancement

If you’re curious about what we have to offer, this section enumerates the reasons why you should consider testing
QBTrak. Tigerpaw’s built-in method of transferring accounting data to QuickBooks is through batching IIF files.
Below is the basic process described step-by-step:

1. Navigate into each of the accounting areas in Tigerpaw (Accounts, Invoices, Payments, General Journal and
Purchase Orders) and Create a Text File (IIF file)

2. Open QuickBooks; log in as the QuickBooks admin; change to single-user mode (logging out any other users)

3. Import the IIF file

With QBTrak you may not need to have QuickBooks open, it works in multi-user mode, and, generally speaking, the
process is automated so there’s less hands on work involved. As long as QBTrak is running and configured properly
it will periodically move information over to QuickBooks and provide insight as to what must be done if something
isn’t right.

Error Handling

Error handling is a huge feature for QBTrak. What happens if there’s a problem with the data contained in an IIF
file? A precise error is not generated when QuickBooks encounters a problem in an IIF file (e.g. “Error on line 14:
...”). Importing a bad IIF file can lead to partial imports and the resolution is to double-key remaining transactions
into QuickBooks or dive into fixing the IIF file and risk duplicate data being created in QuickBooks after trying to
import a second time.

With QBTrak, transactions which do not properly export to QuickBooks remain in Tigerpaw’s batch 0. Furthermore,
a [usually] human-readable error message flags this transaction so that measures can be taken to correct the situation.

Enhancements

Here are just a few of the enhancements to the data contained in our transactions over manual batching:
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2 CHAPTER 1. INTRODUCTION

• Credit Hold flags Tigerpaw accounts on Credit Hold based on the QuickBooks aging report

• Account Export sends over the Account Number

• Invoice Export sends over an SO Number associated with the invoice, and SO Reference

• Invoice Export sets the sales tax code natively in QuickBooks to properly track sales tax

• Payments are applied to invoices in QuickBooks after moving over

• PO Export can be activated to create a PO in QuickBooks and recognize liability as items are received

• PO Export can create a vendor bill for your approval

• Time Sheet export can be used to more accurately cost or used for QuickBooks Payroll

Backward Compatibility

While not necessarily a feature, we do like to advertise that the standard QBTrak modules (Account, Invoice, GL,
Payments) are all backwards compatible with Tigerpaw’s manual batching, so there’s nothing locking you into using
our product in perpetuity. In the rare event our product has difficulty handling a certain transaction, manually
batching can be used as a backup plan.



Chapter 2

Getting Started

2.1 Installation Procedure

Prerequisites

In order to install and use QBTrak there are several requirements which must (or should) be met:

• A reasonably recent version of Tigerpaw must be properly installed, configured, and operating; it is not neces-
sary to have Tigerpaw installed on the same computer as QBTrak, but QBTrak will be utilizing the Tigerpaw
database which must be of a recent vintage

• A currently supported version of Microsoft Windows (e.g. 10, 8, or Server 2019) with latest service packs, and
patches applied (I don’t wring my hands over updating the manual as new operating systems are released, so
newer stuff is probably supported too)

• Microsoft’s .NET 4.5 framework must be installed

• The QuickBooks user interface must be installed with the latest patches on the computer chosen to run QBTrak;
editions Enterprise, Premier, or Pro are supported (this, too, should be a reasonably modern version)

• The Tigerpaw Accounting Link must be properly setup between Tigerpaw and the QuickBooks; if you can
manually batch, our product is mostly ready to drop in and automate the process

• Familiarity with using the Tigerpaw Accounting Link to manually batch transactions

Installation

This is pretty dry information. Most of this is covered by the quick-start guide. You could probably skip this section,
referring to it if you need more details than is provided by the quick-start guide.

Where should QBTrak be installed?

QBTrak must be installed on a computer where QuickBooks user interface is installed and operating. We require
the QuickBooks user interface to connect to the company file. Installing on a QuickBooks server is sufficient only if
the QuickBooks user interface is also installed.
We recommend installing on an accountant’s or bookkeeper’s PC so they can access and evaulate the export results,
but installing on a server is a fine choice as long as the QuickBooks user interface is also installed on the server.
QBTrak will not run as a Windows Service, so someone must be logged into the server and running QBTrak for
information to export. Additionally, see the Appendix for details on how QBTrak uses a QuickBooks license.
QBTrak should only be installed on one computer and must not be running more than once on either the same
computer or on different computers unless it is connected to separate a Tigerpaw database and QuickBooks company
file.
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4 CHAPTER 2. GETTING STARTED

Obtaining and installing QBTrak

This manual probably came from the .zip file package that was downloaded. In the .zip package is setup.exe which
will install QBTrak’s dependencies and files to your computer. Run this setup.exe and follow the on-screen directions
to completion. It’s a pretty basic next-next-next kind of thing.

If you cannot find the .zip file package, maybe you downloaded this manual from our website or someone handed it
to you. Call up support and ask us about the installation package so we can e-mail you a link to download.

Setup

Open QBTrak by finding its shortcut in the start menu (click on Start > Programs > Tigertrak > QBTrak > and
run the QBTrak shortcut). When running QBTrak for the first time a series of dialogs will ensure you connect to
both the Tigerpaw database and QuickBooks, register your software, and enable some modules.

1. Select Database – A prompt to select your Tigerpaw database will be the first to display. Follow the on-screen
dialog to connect to the server, and choose which SQL database houses Tigerpaw.

2. Registration – Immediately after connecting to a database, the registration dialog will display. Fill in the details
if they are not accurate. These values are linked to the Company Options in Tigerpaw, so making changes here
will be reflected in Tigerpaw. Click Register then Close when finished.

3. Connect to QuickBooks – Here’s where most people get tripped up because QuickBooks is pretty strict when
it comes to allowing other software access to the company file data.

(a) QuickBooks must be installed and running on the computer. If you cannot open the QuickBooks company
file from the computer where you are installing QBTrak, then you will not be able to connect QBTrak.

(b) Open QuickBooks and log in using the admin account. You must be The Admin, not just a user with
full access or admin privileges.

(c) Most of the time it is recommended to create a QuickBooks user with full access to QuickBooks - we
like naming that user Attalus. This user will be designated as the user with which QBTrak connects to
QuickBooks. Since they will have full access, set a strong password and forget it - you won’t need to
remember it.

(d) In QBTrak, click the Connect with accounting software link (available under File > Options > Gen-
eral Options) then browse to and select the company file. You must use the same file path to connect
QuickBooks to the company file and to connect QBTrak to the QuickBooks company file. For example
s:\QuickBooks\QBCompanyFile.qbw and \\server\QuickBooks\QBCompanyFile.qbw, although point-
ing to the same location, are doing so with different paths.

(e) Access must be granted to QBTrak when prompted by the accounting software; QBTrak should be granted
access to QuickBooks even when QuickBooks is not running. If you created a QuickBooks user in step C,
specify them in the drop down box.

Updates

Updates to QBTrak should be installed over top the existing version without uninstalling first.

Uninstallation

QBTrak can be uninstalled by finding it in the Add or Remove programs dialog of the Control Panel. Removing
QBTrak will not remove dependencies which were installed to the computer during the setup process (i.e. QuickBooks
SDK), nor will it remove QBTrak’s settings and database modifications.
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2.2 Navigating QBTrak

Dashboard

The main screen you should be acustomed to seeing when using QBTrak is the Dashboard. The dashboard contains
a few obvious areas we’ll briefly outline here.

General Statistics Shows information such as the database to which QBTrak is connected and QuickBooks com-
pany file locations.

Action Center Indicates the current status of QBTrak whether it’s executing or when it will next execute. Also
in this section, the aptly named ’GO’ button allows one to immediately begin a transfer of data belonging to
the category selected from the drop down list above. If you don’t see the module in the drop down list, then
it isn’t activated.

HUD The Heads Up Display (dashboard group) provide a display to immediately convey the status of the accounting
link. Active modules will be clearly visible while inactive modules will not display up-to-date data and are
grayed out. Each module section displays some very general information, and provides direct access to results.

Figure 2.1: QBTrak Dashboard

Menus & Options

There are a few simple menus which mostly explain themselves, but we’ll provide some extra inforomation below
were necessary.

Under View menu you will find an in-depth Status Log and Error Log, but reading through this mess is mostly for
the curious and our support team if there’s trouble.

The File menu provides access to QBTrak’s Options. Accessing Options from the File menu will display the QBTrak’s
General Options and a navigation list on the left to explore each of QBTrak’s modules. The General Options dialog
contains settings for the program as a whole including the locations of the Tigerpaw database and QuickBooks
company file; the execution interval and schedule.

General Options

The General Options will be explained below while other modules are discussed in Chapter 3 on page 9.

Tigerpaw Database Launches a wizard to aid in the selection of your Tigerpaw database.

QuickBooks Company File Opens an Open File Dialog to browse for the QuickBooks company file or clear
the current connection. See the section on page on the preceding page for more detail on connecting to the
QuickBooks company file if you’re having difficulty.
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Display Console Feeling nostalgic? I freequently do. Coming from an age of command-line computers, I miss
the warm glow of a console and the silent, inviting blink of a monochrome C:> prompt after a lengthy, and
often noisy boot. All that we have left is a windowed shell with no Edit command available: the “Command
Prompt”. If we don’t share this memory, then prehaps you remember Sentry and its industrial-style status log.
“Monitor Running [>]”; “OPTIONS STUB DETECTED...”: what do these fascinating phrases mean and why
hasn’t anything happened in, what’s it been, 40 minutes? But I digress. You probably don’t want to turn this
option on. It’s a console window showing status information while QBTrak operates. This output is logged
to a file available under the View menu. Prehaps this would be helpful if you’re getting acquainted with the
product and are performing some tests, otherwise it’s an eyesore.

Execution Scheduler Adjust to “Execute every n minutes between the hours of x and y.” and QBTrak will go
through the list of enabled modules to find new items to transfer to QuickBooks as advertised. It may be
temping to set this at 1 minute, 24 hours a day, but you should read through the Errata section on page 19 to
understand potential problems with this configuration.

Email Settings At the time of this writing our email connector doesn’t do anything spectacular, so there’s no
compelling reason you should go through the trouble of setting this up. Even if this changes it will be optional.

Figure 2.2: Options > General Options

2.3 Operating QBTrak

Procedure

The procedure when using QBTrak is similar to manual batching, but different enough to merrit an overview. This
overview may help those not familiar with manual batching as well, but a prerequsite for using QBTrak is that you
have setup Tigerpaw for manual batching and understand how to manually batch from Tigerpaw to QuickBooks.
This is a generalized procedure and may not match exacly what is required for different export types. Specific details
about each module will be explained further in each of the module descriptions starting in Chapter 3 on page 9.

Executive Summary

The next 6 steps outline the process of exporting accounting information with QBTrak.

1. Posting a transaction in Tigerpaw puts the invoice into Batch 0

2. QBTrak will try and export anything in Batch 0

3. If an export fails, that transaction is marked with an error message but it remains in batch 0

4. Error messages can be viewed in QBTrak by clicking the "Results" button for the module

5. Once an error has been addressed, use the "Clear Errors" button and QBTrak will then try the transactions
again

6. Goto step 3 if you get a new error

The 6 steps above is are a bit verbse to provide a frame of reference in comparison to manual batching. There are
just 3 things you normally have to worry about which we’ll explain further next.
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Items are readied for export

Items are typically “posted” as a final step indicating they are ready to move to the accounting system. This step is
identical to the process for manually batching from Tigerpaw to QuickBooks.

Posted items (invoices, general ledger, payments) get stored in Tigerpaw’s Batch. Tigerpaw’s Batch is a queue -
the holding place for items that must be sent over to the accounting system. Posted items go to batch 0 (zero).
Tigerpaw’s batch is accessible under the Tools [menu] > Accounting > Configure & Create Accounting Batches.
Occasinally it may be necessary to view the batch to find and make changes to a posted item to correct a problem.

Figure 2.3: Invoice Batch

Exporting

As QBTrak executes, enabled modules will attempt to export items from Tigerpaw’s batch 0 to QuickBooks. Items
successfully exported will be moved from batch 0 to the next available batch number. This is where QBTrak differs
from manually batching. If an item is not successfully created in QuickBooks, it will remain in batch 0 with an error.
If an error is received, QBTrak will not try to export the item again until this error is cleared.

Rectifying Problems

Modules in QBTrak have a “View Results” button used to display a grid containing errors for failed transfers. These
errors are mostly human-readable and primarily come from the perspective of QuickBooks. For example, a common
problem exporting invoices is that the account has not yet been created in QuickBooks. In this case, the error would
read “There is an invalid reference to QuickBooks Customer “Example, inc.” in the invoice.”

Evaulate the reason why a transaction failed to transfer and take corrective action. In the example above, export
“Example, inc.” or create the account in QuickBooks. Then, while viewing the results in QBTrak, there is a button
to “Clear Results”. This removes all errors for the module so QBTrak tries exporting items again.
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Chapter 3

Modules

Modules must be enabled in QBTrak before anything is processed. Modules can be activated and deactivated in the
options accessible under File > Options menu. Selecting a module displays its options, if any, and a checkbox at the
top indicates if the module is turned on or off.

3.1 Account Exportation

The Account Exportation module exports and updates accounts from Tigerpaw to QuickBooks. Enabling this option
collects accounts which have both an ARCustomerNumber and the “Export Customer Information to Accounting”
check box set under an Account’s Accounting Information dialog in Tigerpaw. QBTrak will update accounts in
QuickBooks that already exist if the Export Customer Information to Accounting option is checked again. After
attempting to export or update an account, the “Export Customer Information to Accounting” checkbox will be
unchecked.

The ARCustomerNumber is the binding field linking Tigerpaw and QuickBooks. For all other transactions to work,
Tigerpaw’s ARCustomerNumber must match the Customer Name in QuickBooks. This means that an exception to
customer modifications discussed above is when the ARCustomerNumber of an already exported account is changed
in Tigerpaw. In this scenario, QBTrak will no longer find the account in QuickBooks and a new account will be
created. If this occurrs, the two accounts in QuickBooks must be manually merged.

Figure 3.1: Accounting Information

Vendors

Vendors will also be exported to QuickBooks using this module. Vendors are linked to QuickBooks with their
APVendorID, which can be set in the Vendor Information dialog (found by clicking the [...] button next to “Is A
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10 CHAPTER 3. MODULES

Vendor” check box). QBTrak may create, or change the APVendorID value automatically (by appending a “ (V)”)
if the ARCustomerNumber of the account has been filled in, and is identical to the APVendorID.

If both the ARCustomerNumber, and APVendorID are filled in when an account being exported, and is flagged as
a vendor, QBTrak will export the account as both a customer, and vendor.

Figure 3.2: Vendor Information

Jobs

Sub-accounts, or jobs can be exported to QuickBooks by assigning an ARCustomerNumber specifying the parent
account, and sub-account, or job name in the format (ex: Company:Job).

Procedure Notes

There is no posting mechanism for accounts. The method with which an account is marked for export is described
above. There is also no results button associated with account export. Account export errors are rare and typically
reviewing the data in a Tigerpaw account will reveal obviously misplaced data that caused an account export to fail.
For example, having a phone number in the zip code field can cause a failure because the zip code field in QuickBooks
isn’t long enough to hold an 11 character phone number.

3.2 A/R - Invoice Export

The A/R Exportation automates the transfer of posted invoices and credit memos from Tigerpaw to QuickBooks.

• Department/Class: Individual Line Items within an invoice, or entire invoices belonging to an account which
is to be categorized under a Department/Class will be imported to QuickBooks under the designated Depart-
ment/Class.

• Subaccounts or Jobs: Invoices can be sent to subaccounts, or QuickBooks “Jobs” by using a colin (:) to separate
the company name from the location in the ARCustomerNumber. For example: “Company:Job”.

• Taxes are calculated in QuickBooks by specifying a tax code when exporting invoices. Sales Tax Groups and
Sales Tax Items must be setup in QuickBooks to mirror those existing in Tigerpaw in order to have invoice
totals that match. This setup requires more effort than the manual batch, but the trade off is accurate sales
tax reporting in QuickBooks. There is a difference in the way taxes are calculated between Tigerpaw and
QuickBooks occasionally creating a $0.01 difference between invoices in both programs. This feature can be
disabled using the “Send Tax as Line Items” described below.

• Contrary to the above, taxes may be forced as line items under a few conditions:
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– If you are using the Avalara service, QuickBooks can not calculate tax as described above so taxes will be
sent to QuickBooks as a line item.

– Tiered tax is supported in Tigerpaw, but not QuickBooks. To correct this issue we require that tiered tax
codes in QuickBooks must be set to a 0% rate. Tax calculated in QuickBooks will then come over as line
items, rather than calculated separately between the two programs. Unfortunately, because QuickBooks
does not natively support tiered taxes, QuickBooks reports will not be accurately populated. Sales tax
reports should be run exclusively from Tigerpaw if you are effected by this issue.

– Provider tax is supported in Tigerpaw, but not QuickBooks. When provider tax is applied to an invoice,
the tax will be sent to QuickBooks as a line item.

– If an invoice is both GS Taxed and a progressive invoice.

– If an invoice contains closed assembly items then tax will be sent to QuickBooks as a line item. A closed
assembly may contain both taxable and non-taxable items. A closed assembly (as opposed to an open
assembly) appears as a single line item on the final invoice. Since the single closed assembly item can only
be taxable or non-taxable, the invoice totals between Tigerpaw and QuickBooks could be mismatched.

• Avalara AvaTax Integration: If you are using our Avalara AvaTax integration, invoices are created the same as
when using tiered taxes by sending tax as a line item

Options

QuickBooks Invoice Line Item Detail: Specify the level of detail in ItemCode references will use in QuickBooks
invoice line items. This option allows you to increase the level of reporting available in QuickBooks at the ex-
pense of added complexity.
The recommended setting is None where no ItemCode is referenced. The description field provides an adequate
identifier differentiating lines on the invoice. This is the simplest and most reliable choice.

Note: None is the only choice if you run a cash basis company! The cash basis balance sheet in Quick-
Books will show A/R balances if any level above None is selected!

The next level of detail is Generic where a general item code will be used to describe any material, labor,
special, or freight line item. This option is a fine compromise between no detail above, and full detail below.

The last level of detail is Unique and is not recommended. A unique Item Other Charge item will be cre-
ated in QuickBooks for each ItemID encountered in a Tigerpaw invoice and these items referenced on invoice
lines. The creation of hundreds or thousands of ItemOtherCharge parts in QuickBooks can degrade perfor-
mance, inflate the size and reduce the lifespan of your QuickBooks company file. You may be forced to upgrade
to an enterprise version of QuickBooks. However this could maximize reporting available in QuickBooks.

Send Tax As Line Items: When checked, tax will not be calculated separately between Tigerpaw and Quick-
Books. Instead, tax will transfer to an invoice through line items. This option can be used to correct issues
with tax rounding or to avoid manging tax codes between both programs. The disadvantage of this option is
that QuickBooks sales tax reports are not as accurate when sending tax as line items.
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3.3 G/L Exportation

G/L Exportation automates the batch process previously used to export G/L information. There’s no real magic
here. There is no deviation from the normal procedure. This module doesn’t have any fancy options.

3.4 Payments Exportation

Exportation of receipts and payments entered into Tigerpaw is supported by QBTrak. When a receipt is entered
and applied to invoices for an account, QBTrak will send payments over to QuickBooks. Additionally, payments are
applied to their corresponding invoices.

• Overpayments are supported. When a Tigerpaw receipt is not fully applied to invoices, the overpayment
portion applies to the account designated in Tigerpaw to receive over payments. However a payment is made
in Tigerpaw and the amount exceeds the amount required to settle an invoice in QuickBooks, that additional
money is applied to the account to which the payment is designated, not the account designated to receive over
payments.

Options

Tigerpaw-QuickBooks Tax Rounding Fix: Because invoice taxes are calculated separately between Tigerpaw
and QuickBooks when using QBTrak, a rounding error between the two programs can create a situation where
invoice tax rounds up to be one penny more in QuickBooks than in Tigerpaw. To address this issue, you can
check this box which will add $0.01 to a payment if the remaining balance would otherwise be $0.01 after
payment is applied.

Do Not Run Automatically: There is a potential problem with running the payments module very frequently.
Please see the appendix for a full expalantion about how payment may become duplicated. For customers who
must run every other module very frequently, we include this option to limit payment exports to occur only
when manually using the GO button.

3.5 Automatic Credit Hold

Automatic Credit Hold examines the QuickBooks Aging Report to mark customers with overdue balances in the
accounting system on Credit Hold in Tigerpaw. Not only is an account put on credit hold, but also a note is written
to the credit hold special instructions field in Tigerpaw indicating that QBTrak flagged the account, the amount
overdue, and the date Credit Hold last flagged this customer. QBTrak removes customers from Credit Hold once
their balance has been paid. QBTrak will not remove customers which have been manually placed on credit hold by
a Tigerpaw Representative.
Customers in Tigerpaw are flagged when the Tigerpaw ARCustomerNumber matches the Customer Name of an
account in QuickBooks. This can result in all accounts sharing a single AR Customer Number in Tigerpaw being
flagged for credit hold.

Options

Do Not Run Automatically: Running Credit Hold can be processor intensive and is something that likely doesn’t
need to run every n minutes, or even every day. We recommend leaving this option checked, and manually
running Credit Hold using the GO button on the dashboard.

Days Overdue: Invoices can be considered overdue when they are more than 30, 60, or 90 days late. These dates
are not variable when running the Aging Report, so unfortunately we can’t allow a 45 day option.

Dollar Threshold: A limiting value for placing accounts on credit hold. Overdue debt greater than this value will
cause an account to be put on credit hold, while debt less than this value will be ignored.

Account Groups Never to Credit Hold: Accounts belonging to selected account groups will never be flagged
for Credit Hold.
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3.6 Purchase Order Exportation

Once this module is enabled, Purchase Orders are created after the first PO Receipt is posted in Tigerpaw. Each time
a receipt is posted in Tigerpaw the Purchase Order is updated in QuickBooks to reflect the receipt and, optionally,
a Bill can be created against the PO for the items received.

There are five conditions that must be met before Purchase Orders will begin queuing for exporting:

• AP Feed must be enabled in Tigerpaw (Tools > Accounting > Create and Configure Accounting Settings >
Configure Accounting Interface > General [tab])

• There cannot be a Default GL Receipts Code set in the accounting settings (marker 1)

• There cannot be any GL Receipts Codes set for any price book items
See the snippit in our appendix on page 23 to help facilitate meeting this requirement

• A Freight Credit Account must be set for Bills to be created (marker 2)

• A PO Receipts GL Account should be set (marker 2)

These requirements are itemized in the options for this module. If these requirements are not met the module can
not be activated and the unmet requirement will be displayed in red. It is possible that some of these prerequisites
can become undone after enabling PO export (e.g. a GL Receipt code is added to a price book item). If a prerequsite
becomes undone PO Export module may turn off to prevent damaging transactions (e.g. doubling of transaction
value). A notice will be displayed the next time QBTrak is started, and it’s important to correct the problem
immediately to minimize lost transactions.

Figure 3.3: PO Export Prerequisites

Purchase orders can be modified in Tigerpaw even after being partially received. Changes to the PO are updated in
QuickBooks. There is one limitation we are aware of: reordering items on a PO can lead to a loss of our Transaction
ID linking items in Tigerpaw to QuickBooks. Avoid reordering items in a PO after the first receipt and the PO has
been created in QuickBooks.

Note: It is important to understand that, when enabled, this module will create inventory items in QuickBooks as
they are encountered. Over time, the creation of thousands of parts can slow the operations of QuickBooks,
and an upgrade to the Enterprise version may be necessary.

The items created for this module will have a similar name to that of the Item ID in Tigerpaw, and con-
tain the item number associated with that part. These item names cannot match Tigerpaw’s items exactly.
These items are also created as “Other Charge” items to avoid having to manage them as part of the QuickBooks
inventory.
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Options

Create VendorBills (by posted PO receipts): Vendor Bills can be created as PO Receipts are posted in Tiger-
paw. Frequently, vendors will invoice for only what has shipped. When you post all received items listed on a
packing slip in Tigerpaw, a vendor bill will be created in QuickBooks matching only the items received in that
posting. In this way, we support partial receipts and backorders.

Accounts Payable GL Account for Bill Creation: This is your Accounts Payable account necessary when cre-
ating Vendor Bills. The list of accounts is derrived from Tigerpaw’s Master Tables. If you do not have the
correct AP account, you must add it to your list of GL Accounts in Tigerpaw.

Special Items Expense Account: A prerequisites to using the PO Export module is to specify a PO Receipts
Account in Tigerpaw’s accounting settings. This account is where the value of received inventory is accumulated.
It is likely that you do not wan’t to the receipt of Special Items to work the same way. Special Items are not
inventory controlled in Tigerpaw and this option allows you to specify an account different from Tigerpaw’s
default PO Receipts Account to which the value of received special items will be sent.

Labor Items Expense Account: Similar to the Special Items directly above, the Labor Item Expense Account
enables you to receive Labor Items on a PO without attributing the value of labor to the Inventory Asset
account in Tigerpaw.

Per-Item Receipt Account: You can specify a specific receipt account per PriceBook item if a single receipt
account for material goods and additional accounts for special and labor items is not enough. This is done by
filling out the Accounting Link Sales Code (in Tigerpaw’s PriceBook Item > Admin [tab] > Accounting Link
Sales Code). QBTrak uses this field when it contains a GL Account and optional class separated by a colon
(e.g. “12100:Technology”).

Figure 3.4: PO Export Options

Expense / Receipt Accounts Per Item: A Price Book Item’s Accounting Link Sales Code can be used to over-
ride the receipt / expense account selected in either Tigerpaw’s Accounting options or QBTrak’s PO Options
(i.e. the Special & Labor Items Expense Account explained above). Enter the GL Account into an item’s
Accounting Link Sales Code. The GL Account entered into the item’s Accounting Link Sales Code must exist
in Tigerpaw. It mus also match exactly, so copy-pasting is recommended. If you want to specify a class, use a
colon to separate the account number and class (e.g. "<Account Number>:<Class>").

If the GL Account you entered into an item’s Accounting Link Sales Code does not exist in Tigerpaw or
is not an exact match, then the QBTrak will fall back to using the Special / Labor / ordinary PO Receipt
code.

3.7 Time Sheet Export

By activating the time sheet export module, you can transfer SO Time Logs entries and Time Slips (we’ll call both
these time-related objects Time Entries) from Tigerpaw to QuickBooks. Time sheet export can be used to link
Tigerpaw to the QuickBooks payroll services.
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Configuration is as simple as specifying the QuickBooks Payroll item to use for each combination of Tigerpaw’s Time
Rate Basis + Time Log Reason, and relating Tigerpaw reps to QuickBooks reps.

Time entries will accumulate for export once the time sheet module is turned on. If the module is turned off,
time entries will not accumulate for export – entries created while the time sheet module is turned off can not be
transferred to QuickBooks. Time entries must be approved in Tigerpaw before they will be sent to QuickBooks.

Rate Basis + Time Log Reason = Payroll Item

Time logs in Tigerpaw contain a Rate Basis and Time Log Reason to calculate the value of time. QuickBooks has
Payroll Items. By relating Tigerpaw’s Rate Basis and Time Log Reason to a QuickBooks Payroll item, different
outcomes for the cost of the labor accounted for.

For example, you may have a Time Log Reason of “repair” in Tigerpaw. This “repair” reason can have a Rate Basis
of “regular”, or “overtime”. There is probably a cost and income difference between these two rates, but QuickBooks
only allows Payroll Items. To accurately match the value of time between Tigerpaw and QuickBooks two QuickBooks
Payroll Items can be created: “Repair - Regular”, and “Repair - Overtime” we’ll call them. Finally, in QBTrak,
match the combination of Rate Basis + Time Log Reason to the proper QuickBooks Payroll Item.

Relating Reps

Reps must be matched between QuickBooks and Tigerpaw, and these reps must be manually related for the Time
Sheet export module to work correctly. Time logs will not move to QuickBooks if the rep in Tigerpaw has no
counterpart in QuickBooks.

Time Log Reasons as Service Items

Tigerpaw’s Time Log Reasons are referenced on time entries to enhance reports from QuickBooks. This does mean
that your Time Log Reasons must exist in QuickBooks as service items for the Time Sheet module to work.

Figure 3.5: Time Sheet Service Items
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Appendix A

Trouble Shooting FAQ

Q: Why hasn’t anything moved over to the accounting system?

We’ve enhanced QBTrak to be more up-front about its grievances so hopefully there will be some indicator on the
dashboard as to what the problem is if nothing is working. Typically, if there is a problem with connecting to
QuickBooks a message will be displayed in red in the General Information. If you’ve got errors stacked up, you’ll see
the number of failed transactions in red under each module.

Q: Where are my (Invoices|Payments|JournalEntries); they’re not in my
Accounting System?

See if there are any clues in the results table. Most of the accounting link sub-modules have a results table where
erroneous exports are stored with a [usually] human-readable message hinting at how to correct the problem. If
you’re familiar with your accounting system, correcting the problems should be a breeze.

1. Go to the File [menu] > Module Options > [Sub-Module] > View Results [button].

2. Double clicking on a failed export will give you the reason for the failure.

3. Correct the problem.

4. When viewing the results, click the Clear Results button.

Any stuck invoices/payments/etc. will try and export again the next time QBTrak executes. If there are additional
errors, repeat this process. If you get something real wild in there, call into support, and we’ll explain it the best we
can.

Q: Does QBTrak use a QuickBooks license to connect?

TLDR: If you plan to run QBTrak on a server, then the answer is yes, it will use a QuickBooks license. If you run
QBTrak on a desktop, the answer is maybe depending on how frequently a user is on that computer logged into
QuickBooks. While a human is on the computer with QuickBooks open, QBTrak will use that human’s license. Read
on for all the details and common situations.

When QBTrak executes it makes a connection to QuickBooks. This connection to QuickBooks “travels through”
the user interface (hence our requirement that the QuickBooks UI be installed on the computer where QBTrak is
installed). QBTrak can be configured to connect to QuickBooks even when QuickBooks is not running (a secret,
invisible QuickBooks UI is being launched).

17
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QBTrak will require a license to connect to QuickBooks when QuickBooks is not running as explained above. However,
if someone is logged into QuickBooks on the computer where QBTrak is running then QBTrak will use their login
credentials and borrow their license. This leads to a couple interesting things worth mentioning here.

1. If humans are using all of your QuickBooks licenses and QBTrak tries to connect on an additional PC then
QBTrak will be unable to connect. It will continue trying to connect until a human logs out and a license
becomes free at which point it will pick up where things left off.

2. If humans are using all but 1 of your QuickBooks licenses and QBTrak executes on an additional PC it will
use that 1 remaining license. While QBTrak is executing, a human will not be able to log into QuickBooks.
If you don’t mind the inconvenience, just wait a minute and the license will free up; if you do mind then buy
another QuickBooks license or run QBTrak on a computer where someone is already using QuickBooks so it
traverses through their login.

3. Remember QBTrak can “piggy-back” on a human’s license? If the human does not have sufficient privileges
then some operations may fail when QBTrak is using their connection to QuickBooks. The same operations
would complete when the human closes QuickBooks. It’s best to install QBTrak on a PC belonging to a human
with “Full Access” to QuickBooks with their login credentials.

So does QBTrak use a license to connect or not?

Confused? Ok, here are some scenarios that might answer your question in a more concrete manner.

• I am logged into QuickBooks on the computer where QBTrak is installed:
QBTrak will not use a license. It will connect to QuickBooks through your session and level of access. If your
user account don’t have full access to QuickBooks, QBTrak might not be able to perform all of its duties.

• Nobody is logged into QuickBooks on the computer where QBTrak is installed:
QBTrak will use a license. It will access QuickBooks as the user specified in QuickBook’s integrated applications
settings.

• Nobody is logged into QuickBooks on the computer where QBTrak is installed. QBTrak has been configured
to log into QuickBooks as Admin in QuickBook’s integrated applications settings, but Admin is logged into
QuickBooks on another computer:
QBTrak will not be able to connect to QuickBooks while Admin is logged into QuickBooks on a different
computer than the one on which QBTrak is installed.

Q: Why doesn’t the Tigerpaw Database version match my version of
Tigerpaw?

The database version we reference during initialization doesn’t match (unless by luck) the version of Tigerpaw that
you’re on, so don’t sweat it. Unless where noted in the module descriptions (section 3), QBTrak is compatible with
Tigerpaw databases of a recent vintage.

Q: I have purchased QBTrak, but when I register it says I am in a trial
period!

This is a procedural thing. It sometimes takes a few weeks until we update our customer inventory with your purchase
and during that time you’ll be in a demo period. Everything works and once your account is updated your copy of
QBTrak will be fully authorized.
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Errata

It happens: technical problems occur. We’re going to use this section to detail some of the more prominent issues
we are aware of, and aren’t able to solve.

Duplicate Payments

Duplicate payments can be exported to the accounting system under certain circumstances. There are a couple of
technical reasons why there is no simple solution to this problem. They have to do with the way payment objects
are viewed between the two programs, and how Tigerpaw handles the entry of payments (a lack of entry finalization
by “posting” the receipt and payments).

Because QBTrak automates the batching process, as someone enters a receipt against an account, and payments
against the account’s invoices, if QBTrak were to execute before all payments for that receipt were entered duplicated
amounts will be exported.

To clarify this issue, we’ll use an example.

1. Suzie has received a check in the amount of $1,000 from ABC company to pay off invoices #230, and #231.

2. Suzie enters a receipt for $1,000, and begins specifying payments. First, she creates a payment of $700 to be
applied to invoice #230. She would then create a second payment for invoice #231, but before she has time to
do that QBTrak executes.

3. QBTrak sees the receipt for $1,000, but with only one payment for $700. So QBTrak exports the receipt, and
payment to the accounting system. QBTrak correctly exports the $1,000 receipt, and applies the payment of
$700 to invoice #230, but leaves the remaining $300 as an unapplied overpayment for ABC company.

4. Suzie continues to create the remaining $300 payment against invoice #231.

5. QBTrak will then export the payment for $300 against invoice #231, leaving the $300 overpayment.

The only reports of this problem were from users with an execution interval of 1 minute. Current workarounds for
this problem are to increase the execution interval to 10 minutes or more, significantly decreasing the chance of this
happening; only running QBTrak when receipts not are being entered into Tigerpaw, or using the Do Not Execute
Automatically option in payments and manually executing Payment Export using the GO button.

Invoice Trade-In values not supported

Invoices created with a “Trade In” value go over to QuickBooks without the trade in amount deducted from the
Invoice balance. The amount of the trade in, which should be deducted from the invoice, is instead sent to QuickBooks
as a general ledger entry. This is how Tigerpaw handles these transactions and not a situation we can identify and
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fix automatically with QBTrak. To fix the invoice amount in QuickBooks, create a credit memo against the invoice
in QuickBooks.

The recommended method for handling a trade in is to use a special item with a negative value. This will transfer
an invoice with the expected amount to QuickBooks without additional intervention.

Discount quirk

There is a discount section on a Service Order under the Totals tab. Using the discount area is supported with our
accounting link, but there are two scenarios which you should be aware of.

1. Do not use the “Sell As” feature to increase a Service Order’s total.
Although QBTrak will export these G/L entries, they may be problems with how they effect your accounting.

2. Discounting 100% (or the full amount) of a Service Order’s total causes a discrepancy between Tigerpaw and
QuickBooks once exported.
A bug out of our control causes QuickBooks to still display the tax for items on this SO. To fix, simply change
the Discount line added in the QuickBooks invoice to “TAX” from “NON”. This is only experienced when
discounting 100% (or the full amount) of an SO’s total.

Both of these issues have a similar workaround. Use a line item to increase the cost of an invoice, or to discount the
full amount.

QuickBooks Enhanced Inventory Receiving and Purchase Orders

Do not turn on the QuickBooks Enhanced Inventory Receiving option. This option can not be turned off once it has
been activated. This option will sever the connection between vendor bill creation, and purchase order receipts. We
can not support Bill Creation against PO Receipts at this time if this feature of QuickBooks is enabled.

The only option for handling purchase orders if this option has been enabled is to transfer inventory and costs through
the general journal.

Tigerpaw Non-Stock Items not supported

The Purchase Order module

Progressive Billing

Progressive billing is supported by QBTrak, however Tigerpaw allows the modification of SO parts used until the
final invoice has been created. This can create the situation where a final invoice is actually a negative amount.
Although QBTrak will export this negative invoice, the G/L entries associated with the cost and income of this
invoice will not export. Essentially this would create negative credits which don’t belong in your accounts.

Rather than removing items from a service order in the midst of progressive billing, it would be best to complete the
invoice and issue a merchandise credit memo to balance the total.

QuickBooks Transaction ID or TxnID mismatches

The error “Object <12345-1234567890> specified in the request cannot be found” may be returned when applying a
payment to an invoice or modifying a partially received purchase order. On payments, we have seen this error when
the invoice to which a payment applies is already marked as paid. Discard these payments if the invoice is already
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marked as paid in QuickBook.With purchase orders, these errors can be induced by modifying the PO in QuickBooks
after a partial receipt. By making manual changes to a PO in QuickBooks after a partial receipt, our Transaction
ID is overwritten and QBTrak can no longer modofy a PO. Avoid modifying PO’s in QuickBooks which are partially
received.

If you are receiving this error and the above advice does not apply, this error could be caused by QuickBooks
corruption. The following is a more thorough explanation about what we and QuickBooks are doing and may still
apply in some limited circumstances. The transaction ID (the long string of numbers and letters surrounded in angled
brackets in our example error above) can’t be found in QuickBooks. However, at least the the case of Payments,
QuickBooks just returned the transaction ID in response to a query for the invoice. The process goes something like
this:

1. QBTrak: “Hey, QuickBooks, I’ve got a payment here to which I’d like to apply toward invoice number X for
customer Y. Can you tell me how to locate this invoice?”

2. QuickBooks: “Sure, you can use Transaction ID <12345-1234567890> to find that invoice!”

3. QBTrak: “Thank you! Here’s the payment and I would like it to be applied to Transaction ID <12345-
1234567890>.”

4. QuickBooks: “Whoa! Wait a second there, cowboy. That transaction doesn’t exist!”

If you are encountering many TxnID errors and the invoices aren’t marked as paid in QuickBooks or you haven’t
been modifying partially received PO’s, then the best advise we can give for this problem is to perform these steps
if the QuickBooks company file does not reside on a solid state disk:

1. Shut down QuickBooks

2. Defrag the drive that the QuickBooks company file resides on

3. Open QuickBooks, and under the QuickBooks Utilities, verify, rebuild, and clean up the company data

This has resolved the problem for many, but not all of our customers. You can view the number of database fragments
by hitting “F2” in QuickBooks. More than 100 is bad1, our suggestion would be to keep the number of fragments
below 20.

If this solution does not work for your company file, then the best alternative is to manually batch the stuck payments.

QuickBooks Nightly Backups

We have had a small number of users suggest that repeted QuickBooks company file freezes and, in some cases,
corruption was linked to their nightly backup of QuickBooks. Typically users and programs utilizing the QuickBooks
SDK cannot connect to QuickBooks when a backup is in progress, however there appears to be an unknown link
here that must be mentioned.

QBTrak includes a scheduling component which will alleviate this issue if properly applied.

1Intuit Article INF 1502202https://community.intuit.com/articles/1502202-database-db-file-fragments

https://community.intuit.com/articles/1502202-database-db-file-fragments
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Appendix C

Useful Snipits

You can execute SQL statements from Tigerpaw under the Tools [menu] > Utilities > General Utilities > Execute
a SQL Statement. Copy and paste the statements below to correct problems encountered. Be sure to backup your
database first incase things don’t go quite as expected.

Clear all GL Receipt Codes from all PriceBook Items

The PO Export module can not be activated until no PriceBook items have a receipt code. This is to prevent
double-charging for the cost of received goods.

UPDATE tblPriceBook SET ReceivingGLCode = NULL WHERE (ReceivingGLCode IS NOT NULL)
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Appendix D

QuickBooks Canada (and Beyond)

We officially only support the Canadian version of QuickBooks, but other users around the world with a similar taxing
structure have used our QBTrak to link their Tigerpaw to QuickBooks. We have seen many different approaches to
handling taxes in Canada and QuickBooks. The following is our recommended method and may not be compatible
with the way you are currently handling taxes.

In this section we briefly cover the way taxes in Tigerpaw and QuickBooks are created and applied. This brief review
is important only in building up to our conclusion on how we handle sending tax-related information to QuickBooks.
If you are new to Tigerpaw or QuickBooks and need to know more about how taxes are created or applied, please
refer to their respective documentation.

Provincial Sales Tax

If you do business in provinces subject to PST, then you must create sales tax codes in Tigerpaw and QuickBooks
for these provinces. Below is an example of a Provincial tax code in Tigerpaw.

Figure D.1: Creating a Provincial Tax Code in Tigerpaw

Provincial tax is applied to invoices in Tigerpaw by selecting a tax code at any of many levels: Account, Service
Order, or Invoice. Below we show a tax code applied to a customer at the account level which will act as this
customer’s default tax code.

Did I hear you say “But We Use a Sales Tax Code For GST and/or HST”

So if you only ever do business in an area that charges GST or HST we’ve see a lot of users setup tax codes instead
of configuring Tigerpaw’s native GST described below. This might be OK, but keep in mind that a Sales Tax Code
as described in this section is considered Provincial to us. This will be important later when we’re describing how
to map your tax codes from Tigerpaw to QuickBooks.
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Figure D.2: Applying a Tax Code on the Accounting Options Dialog

Goods & Service Tax

Goods & Service Tax (GST) is enabled in Tigerpaw by navigating to the Tools [menu] > Options > Taxes. By
unchecking “Hide GS Tax related information in windows”, Tigerpaw will apply the GS Tax Rate specified in the
Tax Options dialog to all transactions for accounts not marked exempt from this tax. If you will not be utilizing
GST, do not toggle this option - once it is enabled, it cannot be disabled.

Figure D.3: Enable GST in Tigerpaw

Once you have enabled GST, all transactions for accounts not exempt from GST will be subject to GS Tax at the
rate specified in Tigerpaw’s Tax Options shown above. If you will only ever charge GST, then the [Provincial] tax
code applied to invoices should be an exempt, or zero-rate tax code. See the above section on Provincial Sales Tax
to understand there should not be a tax code specified for the account, SO, or on invoices..

Harmonized Sales Tax or Fully Taxable for Locations No Longer Com-
bining GST and PST Into HST

Harmonized Sales Tax (HST) or Fully Taxable is the combination of both PST and GST. Items in the Tigerpaw
PriceBook can be exempt from Sales Tax (Provincial) or GS Tax exempt. Accounts, likewise, can be exempt from
PST or GST. By setting up both PST and GST as we suggest in this lengthy chapter, items sent to QuickBooks by
QBTrak have this third way of being taxed: HST or Fully Taxable. This allows them to be independently tracked
and handled appropriately.
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How do these taxes appear in QuickBooks

Now that you’re aware of how Sales Tax Codes and GS Tax should be setup and applied in Tigerpaw, lets briefly
review how we expect taxes to be in QuickBooks. If you are using a Canadian version of QuickBooks you will have
a Manage Sales Tax dialog available under the Sales Tax menu. This dialog is shown below.

It’s up to you to configure your taxes in QuickBooks, and we’re not very picky (or knowledgable) about how you
do this. The important thing to note is the Sales Tax Codes section, outlined in red, below. We suggest creating G
for GST, P for Provincial, H for Harmonized, and E for Exempt. These will be the values you supply in the Tax
Mapping dialog we present to you in the following section. Additionally, the Sales Tax Items in QuickBooks should
match the name of your Sales Tax Districts in Tigerpaw.

Figure D.4: QuickBooks Sales Tax wizard

This is how these Sales Tax Codes are applied on QuickBooks Invoice Line Items. In the example below, our Labor
item is subject to GST (G), our CAT 5 Cable is Fully Taxable (S), and our Widget is Exempt (E).

Figure D.5: QuickBooks Invoice with Taxes

Mapping Tigerpaw Tax Codes to Canadian Tax Codes

Now, how do we know which tax codes to apply to each QuickBooks invoice line item? We map them! The “I am
utilizing a Canadian version of QuickBooks and want to map my tax codes” option should be enabled in QBTrak
under the File [menu] > Options > Invoice Export and we can enter the tax mapping dialog by clicking the Tax
Mapping button.
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Figure D.6: QBTrak Canadian Tax Mapping

Below we see a our Tax Mapping dialog. On the left is a list of Tigerpaw Tax Codes and on the right is our map
specification to QuickBooks. As you can see, items that are found to be subject to Provincial, GST, both and neither
can be assigned independent QuickBooks Sales Tax Codes.

Tax GST Tax GST is not supported at this time and you’ll get a warning if this option is enabled. When Tax
GST is enabled for a tax code, the amount of GS Tax on an invoice will also be taxed at the provincial rate:
a double-taxing. To the best of our knowledge this is no longer applicable anywhere in Canada.

Tax Harmonized This checkbox has no effect in Tigerpaw or QuickBooks that we know of. It’s simply a way
of marking a tax code that charges both PST and GST as paid to a single vendor (harmonized) or paid to
separate vendors (fully taxable).

Tax Code This field is unused by QBTrak but is included because it was part of Tigerpaw’s import process

Provincial Tax Code If an item on an invoice is subject to Provincial tax, we will apply this tax code to that line.

GST Code If an item on an invoice is subject to GS Tax, we will apply this tax code to that line.

Fully / Harmonized Tax Code Based on the state of the Harmonized checkbox described above, this field will
be either Fully Taxable Code or Harmonized Tax Code and will be applied to line items on an invoice that are
subject to both taxes: Provincial and GST.

Exempt Tax Code If an item on an invoice is not subject to either PST or GST, we will apply this tax code to
that line.

Additional Requirements

The best way to setup your taxes in Tigerpaw and QuickBooks is ensure your Tigerpaw Sales Tax Districts match
your QuickBooks Sales Tax Items. See Tigerpaw’s Tax District “PST (BC)” (below, left) and QuickBooks Sales Tax
Item “PST (BC)” (below, right).
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Figure D.7: Tigerpaw Sales Tax Districts & QuickBooks Sales Tax Items
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Appendix E

Contacting Support

Support is generally available between 9 and 5 Eastern time, Monday through Friday excluding holidays.

When contacting support, please describe your problem with a level of detail that will enable us to prepare an
immediate response. This is especially important when sending an e-mail or leaving a voice mail because it makes
getting back to you easier if we know what we’re walking into and aren’t assuming any conditions of your situation.
Consider we are exchanging information about abstract concepts, so try to reduce ambiguity: explicit is better than
implicit.

We prefer e-mail over phone support. While writing clearly can be more difficult its asynchronous nature means
more people get help in a shorter period of time and a written exchange can more easily be referenced rather than
recalled by memory. We use screen shots a lot which clearly shows the problem and resolution without the overhead
of starting an online meeting. That being said if your question or problem is difficult to describe succinctly, please
call.

Consider QBTrak’s role: transactions posted in Tigerpaw go to batch 0 which are then moved to QuickBooks by
QBTrak. The boundary of where our role lies can be fuzzy, but we may have a hard time advising on problems
with Tigerpaw sending things to Batch 0, and likewise how to operate QuickBooks. That is to say Tigerpaw and
QuickBooks may be better at providing support about their own products. Please ask, but if your question relates
far outside of the narrow role that QBTrak plays acting as courier we may point you in the direction of Tigerpaw /
QuickBooks support or suggest the advise of an accounting professional who understands both systems.

• email: support@attal.us

• phone: 215.358.1600
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Appendix F

Legal Stuff

Attalus Sentry/QBTrak Copyright (C) 2004-2019, Attalus / Acteon Networks, LLC

The Acteon, and Attalus logos, and all related elements are trademarks of Acteon Networks, LLC.

The Tigerpaw name, logo and all related elements are trademarks of Tigerpaw Software Inc.

The Intuit and QuickBooks logos, and all related elements are trademarks and service marks of Intuit Inc., or one
of it’s subsidiaries, registered in the United States, and other countries.
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